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Introduction
PR-Tracker will help you to manage the development of your product by focusing 
development effort on the tasks required to bring your project to completion. PR-Tracker 
does this by recording the defects of a product during the development and maintenance 
cycle as problem reports and by tracking the process of correcting those defects.
PR-Tracker helps you to manage your project by assisting you to perform 
these tasks:
· Records problem reports in a network database.
· Supports simultaneous access to the database by multiple users.
· Supports multiple projects.
· Supports configuration of data collection for each project.
· Supports configuration of workflow for each project.
· Redundant data storage for speed and backup.
· Classifies problems according to priority, type, and other properties.
· Supports sort and search operations on the database or problem reports.
· Assign personnel to perform the tasks required to correct defects.
· Tracks the tasks of problem investigation, resolution, and verification.
· Estimates personnel work load.
· Determine which testing methods are most efficient in detecting defects.
· Help estimate the time required to complete the projects.
In addition you may also configure PR-Tracker to suit your company's data collection and
workflow needs.



Installation
To install PR-Tracker you will need to perform two steps:
1. Install the PR-Tracker database on the network.
2. Install the PR-Tracker program on each workstation that will use it.
Installing the PR-Tracker Database on the Network
The PR-Tracker database should be installed on a network directory 
that can be accessed by all the users that will be using PR-Tracker. 
Before installing the database you will need to know where you want to
install the database. You can move the location of the database later if 
you wish. To install the PR-Tracker database do these steps.
1. Run the SETUP.EXE program.
2. Select the command button Install Database and respond to the 

prompts. 
The Install Database operation also installs the PR-Tracker program. Unlike the database,
the program should be installed in a directory on a local hard drive.    The Install Database
operation also copies all the PR-Tracker setup files to the network.    This way other users 
can install PR-Tracker from the network.

Installing the PR-Tracker Program on Workstations
Before installing the PR-Tracker program you should know where on the network the PR-
Tracker database was installed. Once you know the drive and path connecting your computer to 
the database, install the program by performing these steps:
1. Run the program SETUP.EXE.    The Setup PR-Tracker dialog will appear.
2. Choose Install Program and respond to the prompts.
Note: The license agreement permits you to install the PR-Tracker program on as many 
computers as you like provided that only authorized users use the program.



Registering PR-Tracker

If you have not registered PR-Tracker, the License Setup dialog will be displayed each time PR-
Tracker is started to remind you to register. Once you have registered the PR-Tracker License 
Setup dialog will no longer appear, provided that your license covers all the users that you have 
authorized to use PR-Tracker.
To register PR-Tracker, print the order form from the License Setup dialog, fill in the 
requested information and send it to us by FAX or postal mail. We will send you a 
registration number and license code. Enter these into the License Setup dialog to 
complete the registration. After you have registered PR-Tracker, you can add to your 
license at any time by upgrading your license



Upgrading Your License

You can increase the number of users licensed to use PR-Tracker by purchasing an upgrade to 
your license. When you purchase a license upgrade, we will send you a new license code which 
you enter at the License Setup dialog. When ordering a license upgrade, please use to PR-
Tracker Order Form which you can print from the License Setup dialog. This way we will know 
your current registration number and license code. When you have recieved you new license 
code, complete the upgrade by doing these steps:
1. From Setup menu select License. The Setup License dialog will appear. Note: If you do not 

have setup privilege you will not be able to do this.
2. Enter your new license code and choose Ok.
3. A message box will appear to confirm the number of users licensed to use PR-Tracker. 

Choose Ok.



Viewing the Problem List
When PR-Tracker is started a summary of the problem reports is listed on the screen. There is 
one problem report summary per line. A problem report summary contains the following 
information listed from left to right.
· The problem report number.
· A single letter which specifies the status of the problem report. The status may be New, 

Assigned, Postponed, Investigated, Resolved, Verified, Failed, or Closed.
· An integer indicating the priority of the problem report.
· The title of the problem report.
· The last field is the date that the problem report was last modified.
The Problem List is sorted according to the problem report number. You can change the problems
that are listed in the Problem List, and how they are sorted, by making a query.
In the Problem List, one problem report is highlighted. The highlighted problem report will be 
referred to as the selected problem. You can change the selected problem in the following ways.
· Press the ¯ or  key to select the next or previous problem report in the list.
· Press PGUP or PGDN to see the next or previous page of problem reports.
· Press HOME or CTRL-PGUP to move to the first problem report, and END or CTRL-PGDN 

to move to the last.
· Mouse click the problem report summary that you want to select (a double click will let you 

view the problem report).



Viewing Problem Reports
To view a problem report highlight it from the Problem List and double-click, or you can be 
more selective by using one of the View menu functions:
· View Selected Problem - takes you to the highlighted problem.
· Goto Problem - allows you to select a specific problem by entering its number.
· Range of Problems - allows you to select a range of problems by entering the first and last 

numbers.
· Set Maximum Problem List Size - allows you to set the number of the problems for the list.
When viewing a problem report, the top half of the problem report contains a menu bar, title, 
originator, problem type, subtype, priority, status, method, assignment and property boxes; the 
bottom half of the problem report form contains the problem description edit box.    The 
description box can be configured, for more information on configuring the description window 
see templates.
The problem report menu bar options:
· Edit - allows you to enter data during each stage, for more information see Editing Problem 

Reports.
· Next - allows you to view the next problem report in the problem list.
· Previous - allows you to see the previous problem in the list.
· Goto - will display a dialog box allowing you to enter the specific number of the report you 

want. 
· Print - prints the problem report, for more information on printing to file see Printing 

Problem Reports. 
· List - takes you back to the Problem List.



Configuring PR-Tracker
There are several ways that you may configure PR-Tracker to suit your company's needs. All of 
the configurable functions are accessible from the Setup menu. In order to perform setup 
operations you must have setup privilege. The user who installs the PR-Tracker database has 
setup privilege by default. Setup privilege can be given to other users, but only by someone with 
setup privilege.
Some of PR-Tracker's configurable functions apply to the entire PR-Tracker system, and some 
apply to each project separately. The functions configurable by PR-Tracker are listed below.
System Configuration
· Add     and     delete     users   from the authorized user list.
· Set user privileges.
· Add and delete project databases.
Project Configuration
· Specify the allowable problem report priority values for each project.
· Specify the allowable problem types for each project.
· Specify the allowable detection methods for each project.
· Specify the property field names for each project
· Specify data entry templates for each project.
· Specify the workflow configuration for each project.
· Specify the custom fields for each project.
When a new project is created, its initial configuration is the same as the current project's 
configuration. You can then customize them to fit the new project's requirements.



Authorizing Users

When you have installed the PR-Tracker database and program, you are ready to authorize 
people to use PR-Tracker. To authorize users do these steps:
1. From the Setup menu select Users. The User Setup dialog will appear. If you are the one 

who installed the database your name should appear in the User List.
2. Enter the name of a user you want to authorize in the User Name field, select the user 

privileges that you want to give them and select the Add command button.
3. Repeat these steps for each user that you want to authorize.
When you have authorized the all the users that you want, choose Ok.
To Delete Users
1. From the Setup menu select Users. The User Setup dialog will appear.
2. Highlight the user's name from the User List.
3. Select the Remove button. A Confirm User Removal dialog box will appear asking if you are 

sure you want to remove the user from the list. Select Yes.
4. The user will be removed from the list, choose Ok.
To Change user privileges
1. From the Setup menu select Users. The User Setup dialog will appear.
2. Highlight the user's name from the User List.
3. Check or uncheck the privileges that you want to change and press the Change Privileges 

button.
New initials will appear after the name in the User List indicating the new privileges.

4. Choose Ok to save the new settings.



Adding and Deleting Projects

PR-Tracker allows you to organize your problem reports under multiple projects, each having 
their own database. When PR-Tracker is shipped, it comes with two project databases that you 
can use to learn PR-Tracker: DEMO1 and DEMO2. Once you are familiar with PR-Tracker, you 
are ready to add your own project.
To add a project :
1. From the Setup menu select Add | Delete Projects or from the File menu select New Project.
2. The Setup Projects dialog appears. Enter the name of    your project in the Project Name 

field.
Tab to the Subdirectory field and create a directory name for your new project. Limit your 
subdirectory name to 8 characters in length. It can contain letters, numbers, or both, and can 
either be upper or lower case letters.

3. Select the Add command button. An information box will appear informing you that the 
project you have just created will have the same setup configurations as the current project 
and that you will need to reconfigure your new setup project settings before entering 
problems. Select Ok. Your project is added to the project list.

4. Select the Close command button. You will be returned to your current project.
To select your new project or another project:
From the File menu choose Open Project, highlight your project name and choose Ok.
PR-Tracker will open up into your new project's Problem Report List. You can keep the previous 
project's configurations or reconfigure your new project.    For more information on configuring 
your new project see Configuring PR-Tracker.

To delete a project:
1. From the Setup menu select Add | Delete Projects. 
2. The Setup Projects dialog appears. Select the project that you want to delete from the 

Existing Projects list box.
3. Select the Delete command button. The project will be deleted from the list.
When a project is deleted the name is removed from the existing projects list; however, no files 
are removed. If you want to delete the project files you will have to do it manually. Locate your 
subdirectory file name in the directory specified by your PRTR_HOME environment variable.
Restoring a previously deleted project
If a project has been deleted you can restore the project as long as you have not manually deleted
the project files. To restore a deleted project, do these steps:
1. From the Setup menu select Add | Delete Projects.

2. The Setup Projects dialog appears. If there exists a project that has been deleted, the Restore
button will be enabled. Click it.

3. A list of deleted projects will apear. Select the project that you want to restore from the list 



and click OK.

Renaming your project
1. From the Setup menu select Add | Delete Projects.

2. The Setup Projects dialog appears. You can rename your project at any time simply by 
clicking the project from the Existing Projects List and selecting the Rename button. A 
Rename dialog box will appear, delete the current name and reenter the new one.

3. Choose Ok.



Priority Setup

When entering problem reports you will want to specify the importance of a problem report by 
giving it a priority.    Pr-Tracker allows up to six priority categories. Examples of five 
recommended priority categories are as follows.
· Blocking    --    this is a problem that must be fixed immediately because it is blocking work 

on the project.
· Critical    --    this problem may result in damage such as loss of significant data or worse. It 

must be fixed before the product is shipped.
· Major    --    this problem is a major functional defect and must be fixed before the product is 

shipped.
· Minor --    this problem is a minor functional defect that should be fixed before the product is 

shipped; however, fixing this problem can be omitted in order to meet deadlines.
· Low --    anything less important than minor.
To configure the priorities perform these steps:
1. From the Setup menu select Configure Current Project 

2. The Configure Project dialog will appear. Select the Priorities tab.
3. Enter a description into the text boxes for each priority number that you want to use. If you 

dont want to use a priority, leave the text box blank.
4. To enable the new priorities choose Ok.



Problem Type Setup

Problem types are used to classify problems into categories or problem types. Each main 
category can be further divided into subtypes. Several schemes can be used to classify problems 
depending on your company's personal terminology and needs.
To add problem types do these steps:
1. From the Setup menu select Configure Current Project 

2. The Configure Project dialog will appear. Select the Problem Types tab.
2. Select the Add type button. A text dialog will appear. Enter your problem type name.
3. Choose Ok.

Your problem type will be added to the list. Continue until you have entered all desired problem 
types. After each individual problem type you may want to add subtypes.
To add subtypes perform these steps:
Highlight the desired problem type from the list. Select the Add type button. A text dialog will 
appear. Enter your subtype name. Press ok. Repeat these steps to add subsequent subtypes.
To delete problem types and subtypes do these steps:
1. From the Setup menu select Configure Current Project 

2. The Configure Project dialog will appear. Select the Problem Types tab.
3. Highlight the name of the problem type that you want to delete from the Problem Type field.
4. Press the Delete command button. The problem type and it's subtypes will be deleted from 

the list of problem types.
4. To delete only a subtype, highlight the problem type containing the subtype from the 

Problem Type field. A list of subtypes will appear. Select the subtype you want to delete and 
press the Delete subtype button.

5. A dialog box confirming your request will appear. Choose Ok.



Detection Method Setup

Specifying how defects in your product are detected will help you to determine which validation 
methods are best suited for detecting bugs. PR-Tracker refers to the ways problems are detected 
as detection methods. PR-Tracker has default detection methods but you can change these to suit 
the needs of each project.
To add detection do these steps:
1. From the Setup menu select Configure Current Project 

2. The Configure Project dialog will appear. Select the Detection Methods tab.
3. Press the Add Method command button. You will be prompted for a new detection method
To delete a detection method do these steps:
1. From the Setup menu select Configure Current Project 

2. The Configure Project dialog will appear. Select the Problem Types tab.
3. Select the detection method that you want to delete and press the Delete command button. 

The detection method will be deleted from the list.



Property Field Setup

Property fields can be used to record true/false information. They appear on the problem report 
form as checkboxes if they are used. The DEMO1 project is setup with 3 property fields: Notify 
Customer, Notified, and Attahment. You can configure up to 4 different property fields.    To 
setup property fields for a project do these steps:
1. From the Setup menu select Configure Current Project 

2. The Configure Project dialog will appear. Select the Properties tab.
3. Enter the names of the propeties you want into the text boxes. Property boxes left blank will 

not appear on the Problem Report form.



Template Setup

If you would like to collect standard data in problem reports for which PR-Tracker does not 
provide data entry fields, you can do this by using templates.    A template causes standard text to 
be automatically entered into the problem desciption edit box of a problem report each time a 
transaction is performed on the problem report.    Templates can be created for each transaction.
To create a template do these steps:
1. From the Setup menu select Configure Current Project 

2. The Configure Project dialog will appear. Select the Templates tab.
2. The Template Setup dialog will appear.    The transactions that can be performed on a 

problem report will be listed on the left of the Template Setup dialog box.    String macros 
which can be used to build template will also be listed.

3. Select the Transaction (example: New, Assign, Postpone, Investigate, Resolve, etc...)    whose
template you would like to customize.

4. The template for the selected transaction will appear in the edit box below.    Edit it to suit 
your needs.

5. Repeat steps 3 and 4 for each transaction.
6. Choose Ok to save your templates.



Workflow Setup

In default workflow configuration PRs are processed in 6 steps: originate (i.e. new), assign, 
investigate, resolve, verify and close -- with the investigate step being optional. This workflow 
configuration is intended for projects that need to be strictly monitored. Your project may not 
require as much control and it may be preferable to reduce the number of steps to process a 
problem report.
PR-Tracker allows you to configure the workflow of each project. You may setup the workflow 
configuration to require as few as 2 steps, or as many as 6 steps to process a problem report. 
Furthermore, you may change the workflow configuration for a project at any time.

To specify the workflow configuration do these steps:
1. From the Setup menu select Configure Current Project 

2. The Configure Project dialog will appear. Select the Workflow tab.
2. Choose the desired workflow options in the dialog.
3. Choose Ok to activate your choices. 

Workflow Options
Workflow Setup dialog allows you to specify the number of steps required to process a problem 
report by selecting workflow options. At the bottom of the dialog is the workflow steps that 
correlates to the selected options is show. Following is a description of the workflow options:
(·) Require PRs to be assigned when originated

If this option is selected all Problem reports must be assigned when they are originated. PR-
Tracker will not allow the problem the be saved unless it is assigned. In other words 
origination and assignment are combined into a single step. The status of all new problems 
saved under this workflow configuration will be Assigned.
The option takes precedence over users privileges. In other words, when this workfow option
is selected all users have assign privilege whether it was given to them in User Setup or not.

(·) Allow PRs to be assigned when originated

If this option is selected, users with assign privilege may assign problem reports when they 
are originated. If all assignements are made the problem will have status Assigned at the end 
of the step. Otherwise the status will be New.

(·) Always assign PRs in a separate step

If this option is selected, users are not allowed to assign problem reports when they are 
originated. The Assign to fields will be disabled for new problems so that data cannot be 
entered.

[X] Allow work on PRs before assignment

The default operation of PR-Tracker is to require problem reports to be assigned before work 
may progress in problem reports. If you want to allow work to progress before assignment, 
check this option.



(·) Require PRs to be Resolved, Verified and Closed in separate steps.

This is part of the default workflow configuration that requires that PRs be resolved, verified 
and closed in separate steps. This configuration is best for projects that require independent 
verification and sign-off by management.

 (·) Automatically Close PRs when they are Resolved

When this option is in effect, problem reports may be resolved and closed in the same step. 
Depending on the Prompt user before closing the problem setting, the user may be prompted 
to close the problem report. If the user agrees, the problem report is closed; otherwise the 
problem report status will be Resolved and it will have to be verified in order to be closed. 
This workflow configuration is best for small projects where developers may be verifying the
PRs that they fix. At the same time it allows a problem reports to be resolved and verified in 
separate steps on an individula basis.

(·) Automatically Close PRs when they are Verified

When this option is in effect, problem reports may be verified and closed in the same step 
Depending on the Prompt user before closing the problem setting, the user may be prompted 
to close the problem report. If the user agrees, the problem report is closed; otherwise the 
problem report status will be Resolved and it will have to be verified in order to be closed. 
This workflow configuration is best for small projects where independent test is required, but
not sign-off from management. 

[X] Prompt user before closing the problem

This option affects the Automatically Close PRs options. If this option is not selected, PRs 
are always closed when they are resolved (or verified). The additional optional steps are not 
available. Note, how the Workflow Steps description changes when this option is toggled.

[X] Allow problem status to be regressed when closing a problem report

When this option is selected, the Status field of problem reports may be modified when a 
problem report is modified using the EditPR | Modify function.    Problem report Status may 
not be advanced however; it can only be set to an earlier state.    

If this option is not selected, the problem report Status field will be disabled so that it cannot be 
modified.



Custom Field Setup 
With custom fields you can collect data about problems and then sort and search the problems 
depending on the value of the fields.    Fields may be of type number, date, text, text choice 
restricted or text choice unrestricted. You may define up to four custom fields. To setup custom 
fields for a project do these steps:
1. From the Setup menu select Configure Current Project 

2. The Configure Project dialog will appear. Select the Custom Fields tab.
3. Select the Add button. The Add Custom Field dialog appears.
4. Enter the desired field properties and press a OK to save them.
Note that the field is shown both in the list and in the preview box below. The preview box 
shows how the field will look on the reserved area of the Problem Report form.    You can modify
the properties of the custom field by double clicking the field in the listbox or by double clicking 
the field label in the preview box.
The following paragraphs discuss various aspects of field definition:
Field Name -- specifies the name of the field as it is stored in the Access database. You may not 

use names reserved by PR-Tracker for the base field set.
Field Label -- specifies how the field will be labeled on the Problem Report form. The field 

label may be the same as the field name but doesnt have to be.
Field Width -- specifies the width of the field according to the number of numeric characters 

that can fit in the field. However, since PR-Tracker uses a proportional font, width does not 
specify the maximum string length. The maximum string length is always 25.

Default Value -- specifies the default value that is entered into the field on the Problem Report 
form. The default value is not entered for the modify transaction, but is entered for all other 
transactions if the field is enabled for that transaction. Default value must match the type of 
the fields. For fields of date type, the default value may be a date or an offset from the current
date. For example, a default value of +7 would always set the value of the field for the date 
seven days from the current date.

Index For Sorting -- specifies whether an index is created in the database to sort the field by. 
Since adding the index enlarges the database and therefore slows down access, you should 
only add the index if you plan to sort by it.    If you only plan to search on the field value, you
dont need it.

Entry Required -- specifies if a value must be entered for the field on the Problem Report form. 
Required entry is enforced for all transactions that the field is enabled for except the Modify 
transaction.



Editing Problem Reports
To edit a problem report select EditPR from the menu. The EditPR menu 
item is available when viewing the Problem List or a problem report. A 
popdown menu will appear which shows the edit operations that can 
be performed. 
You can either create a new problem report or you may assign, 
postpone, investigate, resolve, verify, fail, close or modify an existing 
problem report.
Note that some of the items on the popdown menu are gray and some 
are black. When a menu item is gray it means the operation is 
disabled. All operations in this submenu apply to the selected problem 
report except for New. The New operation is always enabled but the 
other operations will be enabled or disabled depending on the selected
problem reports status and the project workflow configuration.



Creating a New Problem Report

To enter a new problem report from the EditPR menu select New. A problem report form will 
appear on the screen.
When the problem data form first appears on the screen the cursor will be positioned in the Title 
field. Type a brief description of the problem in this field. When you are done, tab to the next 
field. If you want to go back to the title field, press shift+tab or mouse click the title field with 
the mouse.

Your name should be automatically entered in the Originator field, tab past it unless you want to 
change it.
When you tab to the Priority field it will be automatically filled in with the first choice. Select the
¯ key to view the priority choices. When you have made your selection, tab to the next field.
The Problem Type, Subtype and Detection Method fields work the same way as the priority 
field. Once you are familiar with the choices, you may enter your choice quickly by typing the 
first character of your choice and it will be automatically entered. If there is more than one 
choice beginning with the same letter, type the letter repeatedly until you get to the choice. When
you have made your selections, tab to the next field.
The Status field has automatically filled in with a new status, this box will be grayed.
Property boxes will be located in the bottom right hand corner depending on the template setup. 
Check one of these boxes if they apply to the problem. Tab to the next field.
Next, enter a brief description of the problem in the Problem Description Window. Some data 
may automatically be entered depending on the template setup for that stage.
When you have finished making your selection select Save and you will be returned to the 
Problem List.



Assigning Problem Reports

Before a problem report can be closed, there are three tasks that must be performed; 
investigation, resolution, and verification. This step assigns these tasks to different team 
members. To assign these tasks    select the problem report in the Problem List window. From the 
EditPR menu select Assign; the problem report data will be displayed and the cursor will be 
positioned in the investigator field.
Enter the name of the person that you want to investigate the problem. If    you would like to 
choose from a list of names, press the ¯ key and a list of names will appear. Make your selection 
and tab to the next field.
Next enter the number of hours you estimate it will take to investigate the problem. Tab to the 
next field.
Note that the resolution task was automatically assigned to the investigator. You can change this 
if you want. Tab to the next field.
Now enter the number of hours you estimate it will take to resolve the problem. This estimate 
can be refined later after the investigation step. Tab to the next field.
Note that the verification task was automatically assigned to the problem report originator, 
automatic assignment may not occur, depending on the workflow configuration. You can change 
this if you want. Tab to the next field.
Enter the number of hours you estimate it will take to verify the problem. Tab to the next field.
You may change the priority of the problem report at this time if you want. When you are 
satisfied with all your entries, save them in the database using the menu command Save.



Investigating Problem Reports

To investigate a problem first select the problem you want to investigate from the Problem List. 
From the EditPR menu select Investigate. The problem report data will appear with the cursor 
positioned on the Actual Hours field for the investigation task.
Enter the number of hours the investigation required. Tab to the next field.
During the course of investigation you may have developed a more accurate estimate of the 
amount of time required to fix the problem. If would like to change the estimated time required 
to resolve the problem report, do it. Tab to the next field.
If you want to change the estimated amount of time required for verification, do it. Tab to the 
next field.
Your cursor will appear in the Problem Description Window, scroll down to the investigation 
section and describe the information collected during your investigation. This may include 
whether or not the problem is reproducible in the current version and a list of the modules will 
have to be modified to resolve the problem.
When you are satisfied with all your entries, save them in the database using the menu command 
Save.



Resolving Problem Reports

To resolve a problem first select the problem you want to resolve from the Problem List. From 
the EditPR submenu select Resolve. The problem report data will appear with the cursor 
positioned on the Actual Hours field for the resolution task.
Enter the number of hours the resolution required. Tab to the next field.
If you want to change the estimated amount of time required for verification, do it. Tab to the 
next field.
Your cursor will appear in the Problem Description Window scroll down to the resolution 
description section and describe what you did to resolve the problem. This may include a list of 
the modules that changed and what revisions the changes were completed in. You should also 
specify what system version in which changes were incorporated so that the person verifying the 
software checks a version that has the changes.
When you are satisfied with all your entries, save them in the database using the menu command 
Save. Depending on the project workflow configuration, PR-Tracker may ask you if you want to
close the problem report in addition to resolving it.    If you want to close the problem report, 
select Yes; if you want to verify and close the problem report with a separate transaction, select 
No.    
For more information on setting up the workflow configuration see the section on Workflow 
Setup.



Verifying Problem Reports

To verify a problem first select the problem you want to verify from the Problem List. From the 
EditPR submenu select Verify. The problem report data will appear with the cursor positioned on 
the Actual Hours field for the resolution task.
Enter the number of hours the verification required. Tab to the next field.
In the Problem Verification edit window, describe what you did to verify that the problem was 
fixed. This may include the system version that was tested and a test case that failed.
When you are satisfied with all your entries, save them in the database using the menu command 
Save.    Depending on the project workflow configuration, PR-Tracker may ask you if you want 
to close the problem report in addition to verifying it.    If you want to close the problem report, 
select Yes; if you want to close the problem report with a separate transaction, select No.    
For more information on setting up the workflow configuration see the section on Workflow 
Setup.



Closing Problem Reports

To close a problem report first select the problem report you want to close from the Problem List.
From the EditPR menu select Close.    The problem report data will appear with the cursor 
positioned on the Closed by field.
The closer and close date are entered for you automatically, but you can change them if you 
want. 
When you are satisfied with all your entries, save them in the database using the menu command 
Save.    If you dont want to close the problem report, Cancel the transaction and regress its status
to the desired state using the EditPR operation Modify.



Modifying Problem Reports

If you want to modify a problem report without advancing its status, choose Modify from the 
EditPR menu. The problem report will be displayed.    During this edit operation you can modify 
any of the fields except the problem report number.    This includes the status. However, the 
status can only be modified to a regressed state.    You have to use the other EditPR operations to 
advance the status. 



Query--Sorting and Searching
The Query function allows you to select a set of problem reports that have certain properties. You
can create multiple queries and add them to the Query menu. You can also specify the query to 
be used when PR-Tracker is started.
The various query options are as follows:

· Establish a startup query
· Sort according to status, priority, or last modification date or any custom field.
· Select problem reports according to status, priority, type, detection method or other fields.
· Select specific problem reports by problem type and subtype.
· Select specific problem reports by using wild card matching.

Making and Naming your Query
1. From the Query menu select New Query.
2. The Make Query dialog box will appear. Your cursor will appear the Query Name field.

The name of your query will be displayed in the Title bar. Save it by:
Checking the box [    ] Add to Query Menu.    It will appear at the end of the Query Menu. You
can access your query by highlighting it from the menu.
Check [    ] Use for start up Query.    If you would like to view your selected options each 
time PR-Tracker is started.

3. Select the sorting feature that you would like PR-Tracker to sort your query options by:     
number;    status;    priority;    or last modification date.

Selecting problems according to status
To select problem reports according to status click the status checkboxes that correspond to 
problems that you want to select. For example, to list all    "new"  problem reports, 
Check [    ] New

Note that both [    ] New    and    [    ] PRs with status    are checked.    
Choose Ok.    The Problem List will be displayed containing only new problem reports.
To list all problem reports except those that are closed, in the Make Query dialog do these steps:
Check [    ] Closed, choose Invert Status Selections, choose Ok.

Selecting problem reports according to assignment
To select problem reports that have been assigned to a specific person,
Check [    ] PRs assigned to,       Your name will be automatically filled in to the text field. If you 

want to change the name, do it. If you would like to choose from a list of names press ¯  key 
repeatedly; or type the first letter of the name you want repeatedly until it is selected; press 
enter.



Press Ok. All problem reports assigned to the selected person will be listed in the Problem List, 
whether the assignments have been completed or not. 
To see only those problem reports that need work, 
Check [    ]    and that need work,
Check [    ] Now,    This applies mostly to the user assigned to verify a problem. This will 

eliminate from the list problems which have not yet been resolved. Likewise, if the resolver 
is not the investigator, 

Choose Ok.

Selecting problem reports that contain a string
To select problem reports that contain a certain string in a title,
Check [    ] PR contains string,      Tab to the text field and type the string.
Check [    ] or in text,      If you want to search the problem report description, investigation, 

resolution, and verification text for the string.
Check [    ] use wild card matching      to conduct a search using wild card matching. 
Choose Ok.  The Problem List will be displayed containing problems with your specified string 
or wild card match.
Searching for a string in problem report text can take a long time if there are lots of problem 
reports. You can speed up the search by specifying additional selection criteria.

Select problems that have been modified in the last 3 days.
1. Select Modification Date as the field, less than as the relation, and -3 as the value.
2. Choose Ok.

Selecting problem reports satisfying multiple criteria
You may reduce the subset of problem reports more by specifying more than one search 
criterion. If you specify multiple selection criteria then a problem report must match all of the 
selection criteria to be selected.
For example, to select all problem reports that are not closed and with priority of 1 or 2, do these 
steps.
1. Check [    ] Closed

2. Press command button Invert

3. Select Priority from a combo box at the bottom of the Query form.
4. Tab to next field and select less or equal

5. Tab to the next field and enter 2.
6. Choose Ok

Selecting all problem reports
From the Query menu select List all Problems.    The Problem List will be updated containing all 



the problems entered on the project.



Edit Query
1. To edit an existing query, select Edit Query from the Query menu.
2. A Select Query to Edit dialog box will appear. All Queries will be listed in the box. Highlight

the desired query and choose Ok. The Edit Query Menu Item dialog will be displayed. It will 
show the options that were specified for the selected query.

3. Make the desired changes to the query and choose Ok.



Delete Query
1. To delete a query from the Query menu, select Delete Query from the Query menu.
2. A Select Query to Delete dialog box will appear. Make your desired selection from the query

menu items and choose Delete.



Set Startup Query
The startup query is the list of problems that is shown in the problem list when PR-Tracker is 

started.
1. To select or change the startup query, select Startup Query from the Query menu.
2. The Select Startup Query dialog box will appear. Make your desired selection from query 

menu items and choose Ok.
If you select the Query menu again, you will notice that the startup query is the first saved query 
listed in the menu.



Refresh Query
The function perfoms the current query again and updates the problem list. To perform this 
function, select Refresh from the Query menu.



Printing Problem Reports
Problem reports can be printed individually or in groups. To print an individual problem report, 
from the File menu choose Print Problem.    The printed sheet will contain the selected problem 
reports details.    To print the Problem List screen, from the File menu select Print List.    Your 
printed copy will contain only the list that is currently displayed on the Problem List screen. 
To print a group of problem reports see the section on generating reports.
You can also Save your report in a Text file or export to Html format, to do that preform these 
steps:
1.    Select a problem or create a query containing the list of problems or a you want to save as

text or save to html format.
2. From the File menu select Save Problems as Text, or Save problems as Html.... The Save As

dialog box will appear.
3. Select the folder to which you want to store your data and type in your file name.
4. Choose Ok.



Generating Reports
PR-Tracker enables you to generate several useful reports. 
The various report options are as follows:

· Status Summary
· Work Remaining Summary
· Work Remaining by User
· Transaction Log
· Transaction Summary
· Transaction Summary by Priority
· Detection Method Statistics
· Reports for a Range of Problems
· Reports for All Selected Reports
· List of Selected Reports
To generate one or more reports do these steps.
1. From the Report menu select the desired report. 
2. The Report dialog will appear.
3. In the Send Report To option box select ( ) display, ( ) printer, ( ) Text file, ( ) or Html file,      

instructing PR-Tracker where you want to output the report. If the option is grayed it is not 
available for that report. If    you choose file, enter the file name that you want the reports 
sent to.

4. Choose Ok. The reports will be printed and you will be returned to the Problem List.
Status Summary Report
The Status Summary report provides statistics on the number of open problem reports. The open 
problem reports are broken down by status and priority.

Work Remaining Report
The Work Remaining report calculates the number of hours required to close all assigned 
problem reports. The work remaining is summarized according to the tasks of investigation, 
resolution, and verification and according to priority. Work remaining on problem reports with 
status new are not included in this report, so it is best if all new problem reports are assigned 
before generating this report.

Work Remaing Report by User
Provides a breakdown of the work remaining by for each user.

Transaction Log Report



The Transaction Log report is a list of all transactions that have occurred between two dates. 
Transactions include originating (creating a new), assigning, postponing, investigating, 
resolving, verifying, failing, closing, and modifying reports.
Each transaction entry lists the date, time, problem report number, transaction, and person 
performing the transaction. One thing that you can use this report for is to determine what work 
has been done this week.

Transaction Summary
The Transaction Summary report provides a summary of the transactions made for each day or 
for each week.

Transaction Summary by Priority
The Transaction Summary by Priority report provides a summary of the New and Close 
transactions by priority made for each day or for each week.

Detection Method Statistics Report
The Detection Statistics report lists how many problems were detected by each test method, and 
what the priority break down is. This report lets you know which test methods are most effective 
in detecting errors. If you track the number of hours spent doing each kind of testing you will 
have a better idea about how effective these methods are.
Reports for a Range of Problems
This report provides all the details of a consecutively numbered set of problem reports. When the
Reports dialog is first displayed the first report number field is 1 and the last report number field 
is the total number of problem reports.

Reports of All Selected Reports
This report provides all the details for all the reports listed in the Problem List. The problems 
listed in the Problem List can vary depending upon the query selection. For more information on 
queries see section Query--Selecting and Searching.

List of Selected Reports
This report provides the summary information for all the problems listed in the Problem List. The
summary information is the information shown in the Problem List. The problems listed in the 
Problem List can vary depending upon the query selection. For more information on queries see 
section Query--Selecting    and Searching.



Command Line Arguments
PR-Tracker supports the following command line arguments:
/i <initilazation file>
Normally PR-Tracker reads the PRTRACK.INI file to initialize program variables. This option 
allows you to specify an alternate initialization file. 
This may be useful if you want to use a different set of queries for each project, if you have more
than one user on the same computer, or if you want to use the same PR-Tracker settings on 
multiple computers.
        PRTRACK.EXE /i "TOM.INI"
        PRTRACK.EXE /i "\\TOM\PRTRACK\PRTRACK.INI"
        PRTRACK.EXE /i "PROJECT2.INI"
/u <user name>
Use this option to override the username specified in the initialization file. If there are blanks in 
the user name then the user name must be enclosed with quotes. For example:
        PRTRACK.EXE /u "Tom Tester"
/p <project subdirectory>
Use this option to override the project setting in the initialization file. Note that <project 
subdirectory> is not the project name. It is the subdirectory listed to the right of the project name 
in the Select Project dialog. 
Example:
        PRTRACK.EXE /p "DEMO2"



Moving the Database
If you want to move the PR-Tracker database, you must move the whole database directory 
structure. The top level directory contains the PRTRACK.KEY file. It also contains one directory
for each project. All files must be moved together.
After you move the database, each workstation using PR-Tracker must know how to find the 
new database. PR-Tracker uses the database_home variable in the PRTRACK.INI file to find the 
database.    You must use a text editor like Notepad to edit PRTRACK.INI to change the setting 
of the database_home variable to point to the new database directory.
If the PRTRACK.INI file is not modified after moving the database an error message will be 
issued when the PR-Tracker is started that says: Error opening PR-Tracker key file.



Importing Data
You can import data from another Windows problem tracking system using a Windows script 
language like MS-Test, QA-Partner or WinRunner to transfer the data.
Another way to import data is to user the Rebuild option of the Database Repair Utility. In order 
to do this you need to know a little about how PR-Tracker stores its data, which is explained in 
the next paragraph.
The data files for each project are stored in their own directory. They include an one .PR file for 
each problem report, an .MDB file, and a .CFG file.    The .PR files contain all the problem report
data in text format. The .MDB file has all the data that is in the .PR files except the detailed 
description. The rebuild function creates the .MDB file from the .PR files.
To import the data do these steps:
1) Create a new project and configure it as desired. This creates the .CFG file and .MDB file.
2) Export your data to .PR files and put them in the project directory. You can use a text editor 

to view the .PR files and determine the format. The files should be named consecutively like 
0001.PR, 0002.PR, etc. 

3) Perform the Rebuild operation with the Database Repair Utility.    This writes over the .MDB 
file created in step (1).

After completing these steps the import will be complete.



Copying Problems From One Project To Another
Is some case you may want to copy a set of problems from one project to another. You may want 
to do this when you have a release or when the database gets so big that it begins to slow down. 
In either case you may want to copy all non-closed problem reports to another project. You can 
also use this feature to mearge projects or to divide a project in to multiple projects.
To copy a set of problems to another project do these steps.
1) Perform a query to select the problems that you want to copy.
2) From the File menu select Copy Problems To Project .... The dialog Copy All Problems In List 
To Another Project will appear
3) Enter the text that you want prepended to the beginning of each problem copied.
4) Select the project that you want to copy the problems to from the list of Projects.
5) Press OK. The problems will be copied to the selected project.
Note that this copy operation copies properties from one project to the other based on position, 
not name. So if the properties are not configured the same in both projects, the data in the 
property fields will not match.
The best way to assure a match between projects is to create one project while in the project that 
you want copy problems from. This way the new project will have the same configuration as the 
other.



Exporting Data
PR-Tracker can export problem reports (or a subset of problem reports) to HTML format or text 
files.    This feature is useful for companies that want to provide technical support over the 
internet.    PR-Tracker also uses Microsoft Access 2.0 formatted files to store problem data. 
Consequently, data can be read by Access 2.0 or grater and can be exported to any format 
supported by Access.
To export data in HTML format do these steps:
1)    Create or Select a Query containing the list of problems or a selected problem that you 

want to export to HTML format.
2)    From the File menu select Save problems as HTML.    
3)    The Save as dialog box will appear, type in the file name and select the folder to which 

you want to store your HTML data.
4) Choose Ok, the selected list and its problems will be saved in HTML format.



Maximums
Maximum number of problems per project = 9,999
Maximum number of problems that can be displayed in the problem list for Windows 3.1 and 
3.11 is 800. Use a query or View | Range of Problems if you have more than 800 problems in a 
project.
The maximum number of problems that can be displayed on Windows 95 and NT is 9,999.    By 
default the maximum is set to 800. To increase it to 9,999 do menu View | Set Maximum 
Problems List Size.
Maximum number of projects = no pratical limit
Maximum number of users = 500 (if you have a site license, there is no limit)
Maximum number of Problem Types = 50
Maximum number of SubTypes per Problem Type = no pratical limit
Maximum number of Detection Methods = 30



Whats new in our Version Upgrades
Whats new in version 2.04
Whats new in version 2.05
Whats new in version 2.06
Whats new in version 2.07
Whats new in version 2.08
Whats new in version 2.09



What's new in version 2.04
No changes were made to the PR-Tracker database format.
The features added in the 2.04 update are two functions in the View menu.
· Menu item View | Goto Problem enables you to jump to any problem that you specify.    You 

can jump to problems whether they are displayed on the problem list or not.    If you jump to 
a problem that is not in the problem list, the problem summary is added to the list.
This feature is also available while viewing a problem report.
Menu item View | Range of Problem enables you to view the summary of a range of 
problems in the problem list.

Whats new in version 2.05



What's new in version 2.05
We made two major upgrades to PR-Tracker in the lastest release along with several minor 
enhancements.    Except for the change to Access 2.0 format, no changes were made to the PR-
Tracker database in this release or any previous release.
1) PR-Tracker now stores all of its data in Microsoft Access 2.0 format.    This means you can 

use Access or Crystal Reports to make any custom reports not provided by PR-Tracker.
note:    You dont need Access 2.0 to use PR-Tracker.

2) PR-Tracker can export reports (or a subset of problem reports) to HTML format.    This 
feature is useful for companies that want to provide technical support over the internet.

3) Added ability to save a set of problems to text file.
4) The maximum number of problems that can be listed is configurable.
5)    Increase maximum number of saved queries from 10 to 30.
6) Incorporated use of database access by UNC paths.
7) Added File menu to provide alternate access to some functions and provide Printer Setup.
8) Several bug fixes, mostly in regard to error handling.

Whats new in version 2.06



What's new in version 2.06
    1) Comand line options were added for PRTRACK.EXE.
    2) Several workflow options were added.
    3) Several bug fixes
Except for the change to Access 2.0 format in v2.05, no changes were made 
to the PR-Tracker database in this release or any previous release.

Whats new in version 2.07



What's new in version 2.07
    1) The project configuration user interface was reorganized into a tab dialog.
    2) Save Problems as Text was added to the File menu. This saves multiple problem reports to 
multiple text files.
    3) Enabled the Text output option to Reports for a range of problems. This saves multiple 
problem reports to a single text file.
    4) Enabled the Text output option to Reports for all selected problems. This saves multiple 
problem reports to a single text file.

Whats new in version 2.08



What's new in version 2.08
    1) Work Remaining By User report
    2) Transaction Summary report
    3) Transaction Summary By Priority report
    4) Queriers may sort by acsending and descending order.
    5) The rebuild function of the database repair utility restores both the problem data and the 
transaction history. Previously, only the problem data was restored.
Whats new in version 2.09



What's new in version 2.09
    1) Up to four custom fields may be created for each project. These fields may be of type 
number, date, text, text choice restricted, and text choice unrestricted. Each field may also be 
indexed for sorting and searching.
    2) The query feature was enhanced. Queries can be written based on custom fields. You can 
query on equal, not equal, less than, greater than, contains and does not contain. Previously 
queries could only be based on the equals relation. 
One particularly useful aspect of the new query functionality is the ability to query comparing 
date fields to a relative offset from the current date. This is handy if you create a Date Due field.
    3) Copy a problem or a set of problems to another project.    This feature is useful for merging 
projects, dividing a project into multiple projects, or copying all open problems to another 
project after a release or when the number of problems in the database reaches the 9,999 limit or 
becomes too slow.



Registration
Each time PR-Tracker is started the License Setup dialog will be displayed if PR-Tracker is not 
yet registered.. This dialog has all the information needed for registration, including a Print Order
Form button. You may also print the order form from the help About dialog.
Upon receipt of payment you will receive your registration number and license code which you 
enter into the License Setup dialog..



Wildcard Matching
Built in pattern matching provides a versatile tool for string comparisons. The pattern-matching 
features allow you to use wildcard characters, such as those recognized by the operating system, 
to match strings. The wild card characters and what they match are shown in the following table:
Character(s) Matches in 
in pattern expression
? Any single character
* Zero or more characters
# Any single digit (0-9)
[charlist] Any single character in charlist
[!charlist] Any single character not in charlist
A group of one or more characters (charlist) enclosed in brackets ([    ]) can be used to match any
single character in expression and can include almost any characters in the ANSI character set, 
including digits.    The special characters, left bracket ( [ ), question mark (?), number sign (#), 
and asterisk (*) can be used to match themselves directly only by enclosing them in brackets. 
The right bracket ( ] ) cannot be used within a group to match a group to match itself, but it can 
be used outside a group as an individual character.
In addition to a simple list of characters enclosed in brackets, charlist can specify a range of 
characters by using a hyphen (-) to separate the upper and lower bounds of the range. For 
example, [ A-Z ] in uppercase letters in the range A through Z.    Multiple ranges are included 
within the brackets without any delimiting.    For example, [ a-zA-Z0-9 ] matches any 
alphanumeric character.
Other important rules for pattern matching include the following:
· An exclamation point (!) at the beginning of charlist means that a match is made if any 

character except the ones in charlist are found in expression. When used outside brackets, the
exclamation point matches itself.

· The hyphen (-) can appear either at the beginning (after the exclamation mark if one is used) 
or at the end of charlist to match itself.    In any other location, the hyphen is used to identify 
a range of ANSI characters.
When a range of characters is specified, they must appear in ascending sort order (from 
lowest to highest).    [ [ A-Z ] is a valid pattern, but [ Z-A ] is not.
The character sequence [    ] is ignored; it is considered to be a zero-length string.



Postpone
To postpone the work process done on a problem is simply that. It may mean putting a problem 
on the back shelf until certain requirements are met. The postpone option is a convenient way to 
file them aside without neglecting them altogether.



Fail
To fail the process of a problem report is to return it to the developer letting them know that the 
bug or program hasn't passed the test.



Deleting Problem Reports
It is not possible to delete problem reports from the database. This is by design. However, you 
can do EditPR | Modify and write over the invalid problem report. Or you can simply Resolve the
problem report as irrelavent, Close it, and ignore it.
You don't need to delete the Demonstration project problem reports to use PR-Tracker. Just add a
new project by selecting Add/Delete Projects from the Setup menu.



Custom Reports
There is no built-in capability to allowing the user to create custom reports. However, PR-
Tracker uses Microsoft Access 2.0 formated database files to store problem data. So if you need 
to make custom reports, you can use Microsoft Access or Crystal Reports to make them.






